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Step 1. Install Software 

 If you are installing Sage Accpac on a network, first read Chapter 2 in the System 
Manager Administrator Guide, “Planning the Installation.” 

LanPak Note:  You must install one LanPak per user before you can use Sage Accpac. See 
the LanPak Installation Guide. 

Integrated Access Pack If you use applications that access a Sage Accpac database through ACCPAC’s 
XAPI, you will need to install Integrated Access Pack. See the IAP Installation Guide. 

Timecard Users If you have employees who will be restricted to entering timecards, with no access to 
other Sage Accpac functions, you will need a Timecard User license for each 
employee. See the Timecard Users Installation Guide. 

Database Install a database (Pervasive.SQL, Microsoft SQL Server, IBM DB2, or Oracle). 
(Install your database before performing Step 3.) 

  Start Windows and insert the Sage Accpac CD into your computer’s CD drive. 
The Installation screen should automatically appear.  

 If the installation screen does not appear, choose Run from the Start menu, type 
d:\setup (where d = your CD drive), and then click OK. 

  To apply for an activation code now, click that option on the Installation screen. 
  Click “Sage Accpac System Manager,” then respond to installation prompts.  

If you already have an activation code, you enter it in the Activation screen during 
installation, or you can choose the option, “I Will Register Within 30 Days,” so that 
you can begin using the program while you await the code.  

  Install the number of LanPaks you require and apply for activation codes for each. 
  Install Integration Access Pack (if you use it) and apply for an activation code. 
  Install a Timecard User License (if you use it) and apply for an activation code. 
  Install the Transaction Analysis and Optional Field Creator module (if you use 

optional fields) and apply for an activation code. 
  Install Sage Accpac Multicurrency Accounting (if you use it) and apply for an 

activation code. 
  Install accounting modules, and apply for activation codes. 
  Install Crystal Report Server XI and create a Reports folder. 
  Read the Readme file; print it if necessary, then transfer changes to the guides. 

Step 2. Set Up Web Access  

 To allow your users to open Sage Accpac from their Web browsers, you need to run the Web 
Deployment Manager Configuration Wizard.   

  Choose Sage Accpac Web Deployment Manager from the Windows Start menu. 
 This menu item appears only if you chose the option, “Web Setup Files” in the Install 

Components screen during System Manager installation. The Web Setup Files option 
appears only when you install System Manager on a Windows 2003 (or later) server. 

  Read the information on the Welcome screen that appears, then click Next. 
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A. Select a Remoting Channel 

Step 1 tab In this step, you select a channel that Web-deployed Sage Accpac screens will use when 
communicating with the Sage Accpac web server. 

  Select one of the following channel options: 

   Microsoft .NET Framework Remoting  Distributed COM (DCOM) Remoting 

  Click Next.  

B. Configure .NET Remoting Parameters 

Step 2 tab In this step, you reserve a range of ports to be used by Web-deployed Sage Accpac 
applications to allow them to communicate with the server. 

  Specify the following .NET Remoting parameters: 

   Port Range:    to   

   Enhanced Security  

   Encrypt Network Data 
  Click Next. 

C. Configure .NET Desktop Parameters 

Step 3 tab Choose a maximum number of Web Server Objects, then click Next. 
  

D. Configure Component Services 

Step 4 tab Component services generate Web pages when users sign on to the Web-based Sage 
Accpac desktop, and manage server processes if DCOM is the remoting channel. 

  Enter a username and password of a valid Windows user account. 

  Confirm the password, then click Next. 

E. Configure Internet Information Server 

Step 5 tab Because Sage Accpac uses the Microsoft IIS as the Web server for the Sage Accpac Web-
based desktop, you now specify how the Sage Accpac server should be configured in IIS. 

  Specify a virtual directory name (it becomes part of the URL that Sage Accpac users enter 
when accessing the Sage Accpac desktop on the Web). 

  Specify the server name: 
  – If the server will be deployed on the Internet, the name should be the fully-qualified 

domain name (for example, Sage Accpac.yourcompany.com). 
  – For .NET Remoting, the IP address of the server can be used instead of the name. 
  – If the server is deployed on an internal network, the server name can be the 

Windows machine name of the server, or the IP address. If you choose this option, 
the system moves you to Step 6 (next), otherwise, you go to the Step 7 tab (G). 

  Click Next. 
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F. Specify Crystal Enterprise Settings 

Step 6 tab The Sage Accpac server uses Crystal Enterprise for its Web-based reporting. 

  Specify Crystal Enterprise settings: 

  APS Name:   

   User ID and Password:  

  Folder:   

  Click Next.  

G. Install Sage Accpac Web Service into IIS 

Step 7 tab The Sage Accpac Web Service is an XML Web Service that allows third-party applications to 
access Sage Accpac using the SOAP standard. Skip this step if you do not run third-party 
applications that are programmed to access the Sage Accpac Web Service. 

  Select the option to install Sage Accpac Web Service. 

  Specify the virtual directory name that should be used when installing the service into IIS. 

  Click Next.  
The wizard now installs and configures the remoting channel on the Sage Accpac 
Web server, then moves you to the Summary tab. 

Summary tab  Check that the information on the Summary tab is correct, then click Next to proceed to 
the tab labeled “Done.” 

Done tab  Read the information on the Done tab, then click OK to exit from the Wizard. 

Step 3. Set Up Databases 

 In this step, you set up both a system database and your company database. Note that you 
set up a system database before setting up a company database. 

Create DSN  Open the Pervasive.SQL Control Center, then click New Database under the Common 
Tasks tab in the right-hand pane. 

 Select the server, then click Next. 
 Enter a database name and choose a location. 

  Under DB Name Options, select “Bound” and “Create Dictionary Files”. (Do not select the 
option, “Relational Integrity Enforced,” as Sage Accpac checks integrity itself.) 

  Select the “Create DSN” option, and leave Normal as the Open Mode. 

  Click Finish, then close the Control Center. (You now create databases in Database 
Setup.) 

  From Start, Programs, choose Sage Accpac, then choose Database Setup. 

  Enter the system administrator's password to open the Database Setup form, then follow 
Steps A, B, and C. 
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A. Create System Database 

  In Database Setup, click the New button. The New Database form appears. 

  Enter a system Database ID.   
  Select a database type from the drop-down list in the Database Format field: 
   Pervasive  Oracle  Microsoft SQL  IBM DB2 
  Select System as the Database Category option. 
  Click OK. The Edit Database Profile dialog box appears. 
  Enter a description for the database. (The default description is the ID you entered in the 

previous dialog box.) 

Pervasive.SQL 
databases 

 Enter a description for the system database or leave the default (this is the ID you entered 
in the New Database dialog box.) 

  In the Data Source field, select the data source you created in the Pervasive.SQL Control 
Center. 

  If the option is available, select a security model: Classic, or Mixed. 

  To limit user access to accounting data, select the Enable Application Security option in 
the Edit Database Profile dialog box. 

  Click OK to save the system database, and click Yes at the Confirmation message. You 
are returned to Database Setup, where you will see the new system database in the list.  

You now create your company database. Go to Step B. 

B. Create Company Database 

  In Database Setup, choose New, then enter a company Database ID. 

  Choose your database type from the drop-down list in the Database Format field. (Note 
that it must be the same as the system database format.) 

  Select Company as the Database Category option.  
  From the drop-down list in the System Database ID field, select the system database you 

just created. 
  Click OK. The Edit Database Profile dialog box appears. 
  Type a description for the company database, replacing the default.  
Pervasive.SQL 
databases 

 In the Data Source field, select the data source you created in the Pervasive.SQL Control 
Center. 

  Click OK to save your company database, and click Yes at the Confirmation message. 
You are returned to Database Setup, where you will see your new company database in 
the list. 

You now set global security for your users. Go to Step C. 

C. Set Global Security 

 Global security options are set in the Advanced Security Settings dialog box in Database 
Setup. These can be set for both company and system databases. 

  Highlight the database that you wish to assign global security to. 
  Click the Security button in the Database Setup dialog box. This opens the Advanced 

Security Settings dialog box. 
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  Select security options from the following: 
  Require complex passwords. 
  Require passwords to change every   days. 
  Require minimum password length of  characters. 
  Lock out user after  attempts. 
  Enable locked-out user after  minutes. 
  User time server: 
  Server   
  Click OK to return to Database Setup. 
  Click Exit to leave Database Setup. You now open Sage Accpac and activate services 

and accounting programs for your company database. 

Step 4. Run the Sage Accpac Optional Fields Conversion Wizard 

Important If you installed the Transaction Analysis and Optional Field Creator, you must run the Optional 
Fields Conversion Wizard before activating Sage Accpac accounting modules. During the 
conversion process, you will map old optional fields to new optional fields. Then during 
activation of accounting modules, existing optional fields will be converted as per the mapping 
you assigned in the wizard. (See Step 10 for instructions about creating new optional fields.) 

Step 5. Activate Services and Accounting Programs 

 If you are converting from Sage Accpac Plus for DOS, read the Converting From Sage 
Accpac Plus guide before activating Administrative Services, Common Services, and 
accounting programs. 

A. Activate Services 

  Click the Sage Accpac icon to open the Sage Accpac desktop.  

  Enter the administrator password, then select the company name. If this is a new system 
database, you receive a message to activate Administrative Services. 

 If you are converting from ACCPAC Plus, select the “Convert ACCPAC Plus Currency 
Data” option. 

  Click Proceed.  
You will see messages that indicate that data is being activated, and if you are converting, 
you will see dialog boxes for the conversion.  

 When activation for Administrative Services is finished, the Common Services Activation 
dialog box appears. 

  Type a date for the company’s fiscal year starting date or select it using the calendar icon, 
then click Proceed.  

The Company Profile form opens. Go to Step B. 
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B. Create the Company Profile 

 Before creating the Company Profile, decide how many fiscal periods your company uses (12 
or 13), and determine your company’s functional currency. 

  Fill in the information on the Address tab.  
  Click the Options tab and choose a fiscal period:  
   12  13  Quarter with four periods 
  Locked Fiscal Period:  None  Warning  Error 
  Inactive G/L Account:  None  Warning  Error 
  Non-existent G/L Account:  None  Warning  Error 
  Warning Date Range:    
  Enter a Location Type and Code, and a Country Code and Branch if you use these. 
  Use the Finder to choose your functional currency. 
  If you use multicurrency accounting, choose the Multicurrency option. 
  Accept the Default Rate Type, use the Finder to choose one, or click the New button 

to create a new rate type code. 

  If you chose EUR as your functional currency, you must also choose the Euro option.  
This causes the Reporting Currency field to appear. 

 Choose a Reporting Currency (required only for EUR currency code). 
  Click OK to save the Company Profile. (You cannot change your functional currency after 

saving the Company Profile.) 
 You now activate services and accounting programs. Go to Step C. 

C. Activate Services and Programs 

 If you are installing an update to Sage Accpac, and used optional fields in the previous 
version (prior to version 5.3), you must run the Optional Fields Conversion Wizard before 
activating your accounting programs.  

  Highlight the Administrative Services folder on the Sage Accpac desktop. 
  Double-click the Data Activation icon. (If you have previous Sage Accpac data, back it up 

before this step, then, at the message, answer Yes to proceed with Activation.) 
The Data Activation dialog box appears, showing Sage Accpac programs and services 
that have been installed but not yet activated. 

 Activate one program at a time by highlighting each program in the list, then clicking 
Activate. (Note that some programs and services must be activated before others; for 
example, G/L Subledger Services must be activated before Bank Services can be 
activated. If you try to activate a program that requires another to be activated first, you 
will receive an error message.) 

  G/L Subledger Services  General Ledger 
  Tax Services  Bank Services 
  Accounts Receivable  Accounts Payable 
  Order Entry  Purchase Orders 
  Inventory Control  Others 

When the list is empty, click Close to return to the company desktop. 

 

You now add users. Go to Step 6. 
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Step 6. Add Users 

 For each user, you assign a password and set up individual security options. 

  Open the Users dialog box from the Administrative Services folder. 
  Enter a User ID and a User Name. 
  Select an Account Type (either User or Timecard).  

You must select Timecard if this user will be restricted to entering timecards. 
  Select an Authentication Method:  ACCPAC  Windows  Both 
  If you selected Windows, enter a: 
    Domain:  
    Windows User Name:  
  Select a Language. 

  Enter a Password: 

Windows  You do not have the option to enter a password if you chose Windows as the 
Authentication Method, since the user’s Windows password will be used. 

ACCPAC or 
Both  

 You must enter a password if you chose ACCPAC or Both as the Authentication Method, 
even if security was not turned on for the system database this company uses. 

Password 
length 

Make sure that the password is of the length required in the Advanced Security Settings 
dialog box. (See Step 3C.) 

  Select one or more of the following options: 
  User must change password at next logon. 
  Password never expires. 
  User cannot change password. 
  Account is disabled. 
  Account is restricted: 
 Between the hours of:  and  on: 
   Monday  Tuesday  Wednesday  Thursday 
   Friday  Saturday  Sunday  
  Note that when a user has exceeded the maximum number of logon attempts as set in 

Advanced Security Settings, the option “Account is Locked Out” is checked. The 
Administrator clears this option to allow the user to log on again.  

  Click Add to add a new user, or click Save to save an edited User profile, then click Close 
to return to the Sage Accpac desktop. 

 To set up security groups and user authorizations, go to steps A and B. To set up and assign 
UI Profiles, go to steps C and D. If you are not setting up these features, continue at Step 6.  

A. Set Up Security Groups (optional) 

 When you define security groups, you specify which tasks each group can or cannot perform 
for each Sage Accpac program. All companies using the same system database share 
groups.  

  Make sure the Security option was selected in Step 2A for the system database this 
company is associated with. (Close Sage Accpac, then reopen Database Setup to select 
the security option if it wasn’t already selected.) 

  Double-click the Security Groups icon in the Administrative Services folder. 
  Select an application from the drop-down list. 
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  Type a unique group ID (up to 8 characters) and description (up to 60 characters). 
  Check the tasks the group can have access to. (To uncheck a task, click in the box again 

to clear it.) 
  Click Add to save the new security group. 
  Repeat for each application. (Note that Administrative Services, Bank Services, Common 

Services, and Tax Services are considered applications in Security Groups.) 

B. Assign User Authorizations (if you had set up security groups) 

 Note that you assign each user to one security group for each program; all users in the same 
group can perform the tasks defined for the group; the same user can be assigned to different 
groups within the same company. 

  Double-click the User Authorizations icon in the Administrative Services folder. 
  Select a User ID from the Finder.  

  With the cursor in the Group ID column, double-click to reveal a Finder button, then click 
the button to display previously-defined security groups.  

  Select a group from the list. Repeat for each program. 
  Repeat these steps to assign each user to a security group, then click Close. 

C. Create UI Profile IDs (if you are customizing user interfaces for your users) 

 If your users do not need to use all fields in dialog boxes and forms, you can hide the fields. 
(Note that User IDs must be created before you can assign UI profile IDs.)  

  Determine the fields a user will NOT need in windows and dialog boxes. 
  Open Sage Accpac as the ADMIN user. 
  Create your User IDs.  
  Open the window that you are customizing, then choose Customize from the File menu.  
  Click the New button beside the Working Profile field. 
  Enter a unique ID in the Profile ID field (up to 20 characters), and a description in the 

Description field (up to 60 characters).  
  Click Add, then click Close. 
 The Customize window reappears, displaying the new ID in the Working Profile field, and 

with checkmarks beside each control that can be hidden.  
  Click checkmarks beside the controls for the fields that you want to hide.  

The checkmarks disappear.  
  Click Save, then click OK to return to the window you are customizing.  

The fields will be hidden when users assigned to this Profile open this window. 

D. Assign UI Profile IDs (if you customized user interfaces for your users) 

 After creating a UI Profile ID, you assign users to it. You can create as many Profiles as you 
need, and assign each user to a different Profile. 

  Create a UI Profile, then double-click the Assign UI Profiles icon in the Administrative 
Services folder. 

  Select a User ID from the Finder. 
  Click the Finder in the Profile ID column to choose a Profile ID. 
  Click Close to save this Profile ID for the selected user.  
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Step 7. Set Up Standard Printer 

 Your next step is to set up your printer. 

  Choose Print Destination from the File menu on the Sage Accpac desktop. 
  Select one of the following print destinations: 

 Printer 
 Preview 
 File 
 E-mail (then choose PDF or RTF format) 
 Messenger Fax (available only if you previously installed ACCPAC Messenger 1.0) 

  Select from these paper options: 
 Report Paper Size 
 Report Orientation 
 Use A4 in Place of Letter 

  Choose a default paper size for reports that can be printed in both letter and legal size: 
 Letter/A4 
 Legal 

  Click OK. 
  From the File menu, choose Page Setup, then click the Printer button to select a printer. 

Step 8. Add Currency Information 

 If you use multicurrency accounting, you now add your currency information. 

  Double-click each icon in the Common Services Currency folder. 
  Add or edit currency codes and rate types to match your system. 
  Double-click the Currency Rates icon to add currency tables for each currency/rate type 

combination you use, and to enter exchange rates. 

Step 9. Define User Directories 

 If you use a Sage Accpac product that allows customization, you now define user directories. 

  If a Customization Directories icon is visible in Administrative Services, double-click the 
icon to open the form. 

  For each directory to add, select a user ID and company ID, then enter a directory path. 

Step 10. Set Up Optional Fields 

 If you use optional fields, follow these steps: 

  Open the Optional Fields window in Common Services. 
  Enter an ID code (up to 12 characters) for the optional field, then enter a description for it 

(up to 60 characters). 
  Select a type from the drop-down list in the Type field: 
  Text:  Enter a length (from 1 to 60 characters) in the Length field. 

 In the Values grid, enter the text and a description. 

  Amount:  In the Values grid, enter an amount (defaults to 3 decimal places) and a 
description. 
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 Number:  Enter a value in the Decimals field (from 0 to 9). 
 In the Values grid, enter a value and a description.  

The value will automatically have the number of decimal places you 
designated in the Decimals field. 

 

 Integer:  In the Values grid, enter a value of up to 10 numbers and a description. 

  Yes/No:  The Values grid does not appear. Simply enter the optional field code 
and a description. 

  Date:  In the Values grid, enter a date in month/day/year format and a 
description. 

  Time:  In the Values grid, enter the value in hour/minute/second format and a 
description. 

  To ensure that users enter only the values defined for this optional field, select the 
Validation option. (Note, this is not available when you choose the Yes/No type.) 

   If your Type is either Text or Date, and you choose the Validation option, the option, 
“Allow Blank” appears. Choose this option if a blank value is allowed in addition to 
other values. 

 To complete optional fields, open the Optional Fields Setup forms in accounting programs 
(A/R, O/E etc.) to assign the optional fields you just created. 

Set Up Optional Tables (for versions of Sage Accpac prior to v5.3 or third-party products 
that use Sage Accpac optional tables) 

 If you use a Sage Accpac product that has the optional tables feature, install Sage Accpac 
Transaction Analysis and Optional Field Creator and then follow these steps. 

  Double-click the Optional Tables icon in the Common Services folder. 
  Create a table by typing a code (up to 8 characters) and maximum code lengths. 
  Type each code and its data description on separate lines. 

 For further information about optional tables, see the Sage Accpac Transaction Analysis and 
Optional Fields Creator Installation Guide. 

Step 11. Set Up Bank Services 

  Print the file, BANK-SETUP.PDF for the bank setup checklist. 

Step 12. Set Up Tax Services  

  Print the file, TAX-SETUP.PDF for the tax setup checklist. 

When you finish setting up bank and tax services, you will be ready to use Sage Accpac ERP. Refer to user and 
setup guides for each Sage Accpac accounting program for more information. 

 


